
ABSTRACT 

LIU, ALICE. Assessing Sex as a Biological Variable in Oxytocin Receptor Activation and 

Neuroscience Research. (Under the direction of Dr. John Meitzen). 

 

Research has widely demonstrated that sex differences biological exist at multiple levels 

between male and females. Thus, it is crucial to consider sex as a biological variable (SABV) in 

scientific investigation to produce representative results and advance unbiased scientific 

discovery. Here, SABV was investigated at a cellular level in our own experiment, and then 

more broadly by assessing how SABV is employed across neuroscience research studies.  At the 

cellular level, SABV was examined in the context of oxytocin receptor (OXTR) activation of 

medium spiny neurons (MSNs) in the nucleus accumbens (NAc). This mechanism is 

fundamental in understanding how social play is regulated. Social play is a highly rewarding 

behavior with sex differences in phenotype and incidence. Social play is exhibited across many 

animal species, including humans and rodents, and is essential for the development of healthy 

relationships. Chronic social play deficits in the juvenile period have implications in 

neurodevelopmental disorders that show sex differences, reinforcing the importance of 

considering SABV.  Two intersectional neural systems are key components in the mechanisms 

underlying social play behavior. The brain mesolimbic reward system contains a brain region 

called the NAc, which has discovered to regulate social play in juvenile male rat among other 

species, with females much less explored. Secondly, the neuropeptide oxytocin (OXT) is known 

to mediate social behavior in sex-specific ways. Thus, we hypothesized that OXT receptor 

(OXTR) activation sex-specifically modulates the electrophysiological properties of MSN in the 

NAc. To test this hypothesis, the response of resting membrane potential (RMP) to control or 

OXTR selective agonist [Thr4,Gly7]-oxytocin (TGOT)(0.2 µM or 1.0 µM) of NAc MSN were 

recorded from male and female pre-pubertal rats using whole-cell patch clamp in acute brain 



slice preparation. Overall, OXTR activation demonstrated a depolarization in response to to 1.0 

µM TGOT that did not differ by sex, suggesting that this mechanism is not sex-specific. These 

results indicate that OXTR activation can regulate a fundamental electrophysiological property 

of NAc MSNs, providing important progression for understanding the implication of OXT in 

social play and related disorders. Importantly, this response did not differ by sex, invalidating 

this portion of our hypothesis and providing the valuable insight that sex differences must be 

generated via a different mechanism. Regarding SABV across neuroscience research, sex bias, 

the favoring of male research models over females, and sex omission, the lack of sex reporting, 

have repeatedly been demonstrated across time. This is problematic given established sex 

differences in the brain, behavior and neurological disorders. Here, we extended previous 

findings by analyzing sex bias and omission in research articles of six difference neuroscience 

journals in 2020. Our findings showed a complex presentation of SABV in neuroscience 

research. Compared to past analyses, sex omission declined but sex bias remained relatively 

constant. There is increased reporting of research model sex, however SABV was only employed 

in 10% of total articles. There findings are further complicated by the identification of 34 

different research model types with varying degrees of sex bias, sex omission, and employment 

of SABV. A small proportion of articles employed more than one model type. These findings 

show that while sex bias and omission are improving over time, they are still persistent and 

continue to present a complex picture of SABV in neuroscience research. Together, the two 

chapters of this thesis demonstrate how to employ SABV in a cellular neuroscience experiment, 

and then places this experiment within a much broader context, especially given that the vast 

majority of neuroscience experiments do not employ SABV.  
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CHAPTER 1 

Assessing oxytocin receptor activation of medium spiny neurons in the nucleus accumbens 

in male vs female rats 

 

Research in this chapter will be submitted to a peer-reviewed journal:  

Liu, A., Meitzen, J. (2024): Assessing oxytocin receptor activation of medium spiny neurons in 

the nucleus accumbens in male vs female rats. In progress.  
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Abstract 

Social play in human, primate and rodent juveniles is a highly rewarding behavior which 

is critical for the development of healthy social skills. Two neural mechanisms that are crucial to 

regulating social behavior are oxytocin (OXT) and the brain mesolimbic reward circuitry, 

including a key region called the nucleus accumbens (NAc). Social play differs by sex. However, 

little is known about the integrated relationship between the NAc, the role of OXT, and potential 

sex differences. We hypothesized that oxytocin receptor (OXTR) activation influences the 

electrophysiological properties of neurons within the NAc and that this response would differ by 

sex. To test this hypothesis, NAc medium spiny neurons (MSNs) from male and female 

prepubertal Wistar rats were recorded using whole-cell patch clamp in acute brain slice 

preparation. Resting membrane potential (RMP) was recorded and analyzed in response to 

artificial cerebrospinal fluid (ACSF) control or OXTR selective agonist [Thr4,Gly7]-oxytocin 

(TGOT)(0.2 µM or 1.0 µM). Exposure to control or 0.2 µM TGOT did not elicit a significant 

RMP response. OXTR activation in response to 1.0 µM TGOT did display a depolarizing effect 

on RMP. These responses did not differ by sex, suggesting no sex difference was detected via 

our methodology. Overall, these findings provide a foundation for better understanding how 

OXT modulates the neurons implicated in social play behavior and related disorders, providing a 

crucial first step towards improved personalized treatment and novel therapeutic strategies.   
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Introduction 

Social play can be defined as a repeatedly expressed behavior containing elements that 

are aggressive, predatory, and/or sexual in nature, displayed in a modified or exaggerated form 

(Heintz et al., 2017; Vanderschuren et al., 2016; Vanderschuren & Trezza, 2014). Visual or 

auditory signals may accompany or precede these behaviors to signify it is playful in nature. 

Social play behavior is often performed by mammalian and bird species, however it is also 

suggested in reptilian, fish and amphibian species (Dinets, 2023). Social play is abundant from 

post-weaning to early/mid adolescence, and functionality of this behavior during the juvenile 

period is crucial for developing healthy social relationships in maturation (Nijhof & Bird, 2019; 

Sigman et al., 1999; Vanderschuren et al., 2016). Conclusively, early intervention is essential for 

the appropriate development of healthy social behaviors and this it is important to understand the 

neural basis of social play in juveniles before puberty.  

The neural basis of social play has been a target of significant prior research. Previous 

studies demonstrate that social play is a rewarding behavior in rats (Trezza et al., 2010, 2011; 

Vanderschuren et al., 2016). The neural circuits regulating reward are well document, and 

include the mesolimbic reward pathway. One key component of this circuity is the NAc. The 

NAc is a brain region widely involved in modulating rewarding effects, and it is well known to 

be involved in social play but there are limitations to this conclusion (Klawonn & Malenka, 

2018; Manduca et al., 2016). For example, previous data reveals the NAc regulates social play in 

juvenile male rats, however it is unknown whether it exerts similar effects in juvenile female rats 

(Manduca et al., 2016). This lack of information is problematic given the strong evidence 

suggesting the presence of sex differences in social play and neurodevelopmental disorders 

(Marquardt et al., 2023; VanRyzin et al., 2020). For example, when engaging in social play, 

https://www.zotero.org/google-docs/?broken=ZdED3w
https://www.zotero.org/google-docs/?broken=2AVidK
https://www.zotero.org/google-docs/?broken=VMIgQT
https://www.zotero.org/google-docs/?broken=VMIgQT
https://www.zotero.org/google-docs/?broken=nUAySl
https://www.zotero.org/google-docs/?broken=nUAySl
https://www.zotero.org/google-docs/?broken=kdRCvN
https://www.zotero.org/google-docs/?broken=kdRCvN
https://www.zotero.org/google-docs/?broken=oBzuKV
https://www.zotero.org/google-docs/?braQDv


   

4 

 

juvenile males and female rats phenotypically express this behavior differently. Males are more 

likely to initiate play and display behavior described as wrestling, counterattacking, boxing and 

pinning more frequently than females (Vanderschuren et al., 2016; VanRyzin et al., 2020). 

Meanwhile, females are more likely to exhibit evasive maneuvers when playing (VanRyzin et 

al., 2020). Collectively, this diversity of phenotypic and incidence presentation in social play and 

neurodevelopmental disorders indicates that similarities across sex should not be assumed. Thus, 

studying the neural basis of social play in both sexes is imperative to understanding the 

underlying physiological mechanisms driving these sex differences.  

One relevant target for investigating sex difference is OXT action in the NAc. OXT is a 

highly evolutionarily conserved neuropeptide known to regulate a wide spectrum of social 

behavior in sex-specific ways across various species, including humans and rats (Bredewold & 

Veenema, 2018; K. M. Dumais & Veenema, 2016; K. Dumais & Veenema, 2016). OXT-

producing magnocellular neurons of the hypothalamic paraventricular nucleus have been 

demonstrated to project onto the NAc, where OXTRs are predominantly observed in D1 MSNs 

and interneurons (Luo et al., 2022). However, changes in the electrophysiological properties of 

MSNs in the NAc in response to OXTR activation and whether these include sex differences is 

still unknown.  

To address this knowledge gap, here we test the hypothesis that OXTR activation 

modulates the electrophysiological properties of MSNs in the NAc differently in male vs female 

Wistar rats. We focus on RMP, a fundamental feature of neurons that is critically important for 

neuronal excitability and function. RMP is the electrical potential difference across the plasma 

membrane in a non-stimulated state due to the presence of leak sodium and potassium channels, 

among other more minor influences. RMP is a relatively easily testable, fundamental 

https://www.zotero.org/google-docs/?broken=hEqyGX
https://www.zotero.org/google-docs/?broken=8LqcVi
https://www.zotero.org/google-docs/?broken=8LqcVi
https://www.zotero.org/google-docs/?broken=PwgEb4
https://www.zotero.org/google-docs/?broken=PwgEb4
https://www.zotero.org/google-docs/?broken=mq0anm
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characteristic that all neurons possess. This hypothesis is assessed by recording RMP in response 

to a control or the selective OXTR agonist [Thr4,Gly7]-oxytocin (TGOT) (0.2 µM or 1.0 µM). 

To account for possible sex differences, prepubertal male and female Wistar rats are utilized for 

this experiment and sex was treated as a biological variable.  
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Methods and Materials 

Animals  

All animal protocols were approved by the Institutional Animal Care and Use Committee 

at North Carolina State University. Wistar rats were born from timed-pregnant females 

purchased from Charles River Laboratories. Rats were housed with littermates and dam until 

weaning (P21). After weaning, animals were group housed in same-sex cages until experimental 

collection day (P30±1). 23 male and 22 female Wistar rats were utilized for this study. The 

Biological Resource Facility of North Carolina State University housed these animals in a 

temperature and light-controlled room (23 ºC, 40% humidity, 12:12-hour light/dark cycle with 

lights on 7am-7pm). Cages are polysulfone Bisphenol A (BPA) free and filled with bedding 

produced from virgin hardwood chips (Beta chip, NEPCO, Warrengsburg, NY). Animals were 

provided glass-bottle water and soy protein free rodent chow (2020X, Teklad, Madison, WI, 

USA) ad libitum.  

Acute brain slice preparation 

Brain slices for electrophysiological recordings were prepared following previous 

protocols in our laboratory (Dorris et al., 2015). Rats were anesthetized with isoflurane gas and 

killed via rapid decapitation. The brain was dissected into chilled oxygenated sucrose artificial 

cerebrospinal fluid (s-ACSF), containing (in mM): 75 sucrose, 1.25 NaH2PO4, 3 MgCl2, 0.5 

CaCL2, 2.4 Na pyruvate, 1.3 ascorbic acid, 75 NaCl, 25 NaHCO3, 15 dextrose, 2 KCL. 

Osmolarity was between 290-313 mOsm, with a pH between 7.3-7.5. The brain was coronally 

sectioned at 300 µm using a vibratome (Leica), followed by separation of the left and right 

hemispheres. Slices were placed in ACSF containing (in mM): 126 NaCl, 26 Na HCO3, 10 

dextrose, 3 KCl, 1.25 NaH2PO4, 1 MgCl2, 2 CaCl2, for incubation. Osmolarity was between 290-

https://www.zotero.org/google-docs/?NiDPkL
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313 mOsm, with a pH between 7.3-7.5. Slices incubated for 20 minutes at 30-35ºC and then 

allowed to slowly decrease to room temperature (22-23 ºC) for a total resting time of 

approximately 1-5 hours prior to use.  

Electrophysiological recording 

After resting for at least 1 hour, each slice was individually visualized using a Zeiss 

Axioscope equipped with IR-DIC optics, Dage IR-1000 video camera, and 10x and 40x lenses 

with optical zoom. The recording chamber received a continuously perfused flow of oxygenated 

ACSF between 25±0.4ºC. Whole-cell patch clamp recording techniques were employed to record 

resting membrane potentials of MSNs of the nucleus accumbens core (NAcc). Recordings were 

localized within the NAcc, medial of the anterior commissure between Bregma ~2.28 mm and 

~1.44 mm. Glass electrodes (8-19MΩ) contained an internal solution of (in mM): 115 K D-

gluconate, 8 NaCl, 2 EGTA, 2 MgCl2, 2 MgATP, 0.3 NaGTP, 10 phosphocreatine, 0.3% biocytin 

and 10 HEPES, 285 mOsm. pH 7.2-7.4. MultiClamp 700B amplifier attached to a Digidata 1550 

system and personal computer using pClamp 10.7 software amplified, filtered (2 kHz) and 

digitized (10 kHz) signals. Once electrical access to the MSN was established, the MSN was 

acclimated for approximately 3 minutes to allow the resting membrane potential to stabilize (Mu 

et al., 2010). After this stabilization period, a series of positive, depolarizing currents were 

performed to assess action potential (AP) properties, followed by a series of negative, 

hyperpolarizing currents to assess passive and inward rectification properties. Assessment of 

these properties allowed for MSN verification using procedures previously described (Belleau & 

Warren, 2000; O’Donnell & Grace, 1993), in addition to the presence of a medium sized soma. 

RMP was then recorded continuously, and monitored in response to bath application of control 

solution (ACSF) for 1 minute or the selective oxytocin receptor agonist [Thr4,Gly7]-oxytocin 

https://www.zotero.org/google-docs/?Uyztcp
https://www.zotero.org/google-docs/?Uyztcp
https://www.zotero.org/google-docs/?0AXZix
https://www.zotero.org/google-docs/?0AXZix
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(TGOT, 0.2 µM, 1 µM) mixed in ACSF for 1 and 3 minutes, respectivaly. Electrical offset and 

confirmation of MSN location in the nucleus accumbens core were noted after recording. 

Perfusion tubing was rinsed with ddH20 and 70% ethanol after use.  

Data analysis and statistics 

Peak, antipeak and mean of MSN RMP were analyzed in 30 second intervals using 

Clampfit 11.2 software. Peak is defined as the most positive voltage reached during the analysis 

period. Antipeak is defined as the most negative voltage reached during the analysis period. 

Mean is the average of all values recorded for the RMP during the analysis period. For 

population analyses, peak, antipeak and mean RMP values per cell were normalized as a percent 

changed compared with the baseline period. Following a previous manuscript (Krentzel et al., 

2019), percent normalized change was calculated by averaging the values of the recording period 

before exposure, and then using that pre-exposure average to normalize each minutes of the 

recording [ percent change = measured value – average of the baseline)/average of the baseline) 

x 100]. Experiments were analyzed with two-way repeated measures ANOVA (GraphPad Prism, 

version 9.5.1.). P values <0.05 were considered statistically significant. Data are means ± SE.  

 

 

 

 

 

 

 

 

https://www.zotero.org/google-docs/?Uz6S6s
https://www.zotero.org/google-docs/?Uz6S6s
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Results 

 
Figure 1.1. Raw traces of RMP data show different effects in response to control ACSF or TGOT in prepubertal male 

or female rats. Dotted line indicates time of control or drug exposure. A) Raw trace of RMP shows no response to 

ACSF control. B) Raw trace of RMP shows no response to 0.2 µM TGOT. C.) Depolarizing effect is seen in RMP 

in response to 1.0 µM TGOT. 
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Application of control ACSF did not affect peak, antipeak or mean RMP 

To establish a control for our experiment, MSN RMP was recorded continuously in 

response to ACSF application (Figure 1.1A). For all experiments, data was disaggregated 

between males and females to account for sex as a biological variable. For all experiments, the 

data were quantified using a non-normalized analysis and a normalized analysis to account for 

differences in starting RMP across MSNs. No differences in peak RMP was detected in response 

to control ACSF in both the non-normalized (Figure 1.2A, left; Interaction: F(1,2)=0.00, P=0.99; 

Sex: F(1,2)=0.07, P=0.82; Drug: F(1,2)=0.60, P=0.52) or normalized analysis (Figure 1.2A, right; 

Interaction: F(8,6)=0.37, P=0.92; Sex: F(2,3)=0.59, P=0.57; Drug: F(1,2)=0.00, P=0.99).  No differences 

in antipeak RMP was detected in response to control ACSF in both the non-normalized (Figure 

1.2B, left; Interaction: F(1,2)=0.84, P=0.46; Sex: F(1,2)=0.28, P=0.65; Drug: F(1,2)=0.05, P=0.85) or 

normalized analysis (Figure 1.2B, right; Interaction: F(8,16)=0.40, P=0.90; Sex: F(1,2)=0.88, P=0.54; 

Drug: F(1,2)=0.48, P=0.59). No differences in mean RMP was detected in response to control 

ACSF in both the non-normalized (Figure 1.2C, left; Interaction: F(1,2)=12.44, P=0.07; Sex: 

F(1,2)=0.17, P=0.72; Drug: F(1,2)=16.09, P=0.05) or normalized analysis (Figure 1.2C, right; 

Interaction: F(8,16)=0.65, P=0.73; Sex: F(1,2)=0.15, P=0.74; Drug: F(1,2)=1.81, P=0.30). These analyses 

collectively indicate there is no significant RMP response to the application of ASCF as a control 

variable, and that these results are not distinguished between sexes.  
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Figure 1.2. No response was detected in RMP when exposure to ACSF control. There is no sex-specific effect. A, 

left) Non-normalized peak RMP. A, right) Normalized peak RMP. B, left) Non-normalized antipeak RMP. B, right) 

Normalized antipeak RMP. C, left) Mean non-normalized peak RMP. C, right) Normalized mean RMP.  
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Application of 0.2 µM TGOT did not affect on peak, antipeak or mean RMP: possible sex 

difference in antipeak? 

MSN RMP was recorded continuously in response to 0.2 µM TGOT application (Figure 

1.1B). No differences in peak RMP was detected in response to 0.2 µM TGOT in both the non-

normalized (Figure 1.3A, left; Interaction: F(1,6)=0.27, P=0.62; Sex: F(1,6)=0.09, P=0.78; Drug: 

F(1,6)=1.07, P=0.34) or normalized analysis (Figure 1.3A, right; Interaction: F(8,48)=0.69, P=0.70; 

Sex: F(1,6)=0.61, P=0.47; Drug: F(1,6)=1.59, P=0.25).  No differences in antipeak RMP was detected 

in response to 0.2 µM TGOT in both the non-normalized (Figure 1.3B, left; Interaction: 

F(1,6)=0.37, P=0.57; Sex: F(1,6)=6.35, P=0.05; Drug: F(1,6)=0.07, P=0.80) or normalized analysis 

(Figure. 1.3B, right; Interaction: F(8,48)=0.11, P=1.00; Sex: F(1,6)=0.03, P=0.87; Drug: F(1,8)=2.75, 

P=0.14). Interestingly, a significance between sex was indicated in the non-normalized data 

analysis but not the normalized analysis. No differences in mean RMP was detected in response 

to 0.2 µM TGOT in both the non-normalized (Figure 1.3C, left; Interaction: F(1,6)=0.03, P=0.88; 

Sex: F(1,6)=2.36, P=0.18; Drug: F(1,6)=0.19, P=0.68) or normalized analysis (Figure 1.3C, right; 

Interaction: F(8,48)=0.09, P=1.00; Sex: F(1,6)=0.02, P=0.89; Drug: F(1,7)=2.50, P=0.16). These analyses 

collectively indicate there is no significant RMP response to the application of 0.2 µM TGOT, 

and that the results are not largely distinguished between sexes. There is a possibility of a sex 

difference in antipeak, however, the preponderance of data do not strongly support this specific 

conclusion.  
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Figure 1.3. No response was detected in RMP when exposed to 0.2μM TGOT. Interestingly, a sex difference was 

demonstrated in non-normalized antipeak RMP. A, left) Non-normalized peak RMP. A, right) Normalized peak RMP. 

B,left) A significance in sex was found in non-normalized antipeak RMP (Sex: F(1,6)=6.35, P=0.05), but not in drug 

response. B, right) Non-normalized antipeak RMP. C, right) Non-normalized mean RMP. C, left) Normalized mean 

RMP.  
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TGOT (1.0 µM) application depolarizes the RMP in both males and females 

MSN RMP was recorded continuously in response to 1.0 µM TGOT application (Figure 

1.1C). A depolarization in peak RMP was detected in response to 1.0 µM TGOT in the non-

normalized (Figure 1.4A, left; Interaction: F(1,31)=0.83, P=0.37; Sex: F(1,31)=0.00, P=1.00; Drug: 

F(1,31)=6.04, P=0.02) but not the normalized analysis (Figure 1.4A, right; Interaction: F(15,465)=0.66, 

P=0.82; Sex: F(1,31)=1.52, P=0.23; Drug: F(4,111)=1.42, P=0.22). A depolarization in antipeak RMP 

was detected in response to 1.0 µM TGOT in both the non-normalized (Figure 1.4B, left; 

Interaction: F(1,31)=0.51, P=0.48; Sex: F(1,31)=2.39, P=0.13; Drug: F(1,31)=9.58, P=0.00) and the 

normalized analysis (Figure 1.4B, right; Interaction: F(15,465)=1.11, P=0.35; Sex: F(1,31)=0.97, P=0.33; 

Drug: F(3,88)=5.68, P=0.00). A depolarization in resting RMP was detected in response to 1.0 µM 

TGOT in both the non-normalized (Figure 1.4C, left; Interaction: F(1,31)=0.13, P=0.72; Sex: 

F(1,31)=1.73, P=0.20; Drug: F(1,31)=10.12, P=0.00) and the normalized analysis (Figure 1.4C, right; 

Interaction: F(15,465)=0.60, P=0.88; Sex: F(1,31)=0.64, P=0.43; Drug: F(15,465)=6.89, P<0.00). Overall, 

these analyses indicate that there is a depolarizing response in the RMP in response to 1.0 µM 

TGOT in both males and females. 
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Figure 1.4. Depolarizing change in RMP was detected in response to TGOT (1.0 µM). A, left) Non-normalized peak 

RMP (Drug: F(1,31)=6.04, P=0.02). A, right) Normalized peak RMP. B,left) Non-normalized antipeak RMP (Drug: 

F(1,31)=9.58, P=0.00). B, right) Non-normalized antipeak RMP (Drug: F(3,88)=5.68, P=0.00). C, right) Non-normalized 

mean RMP (Drug: F(1,31)=10.12, P=0.00). C, left) Normalized mean RMP (Drug: F(15,465)=6.89, P<0.00).  
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Discussion 

The data obtained conveyed two key findings. MSNs in the NAc displayed a depolarizing 

change in RMP in response to OXTR activation following exposure to 1.0 µM OXTR-agonist, 

TGOT. This is an important finding given that it is the first to show how OXTR activation can 

regulate a fundamental electrophysiological property of NAc MSNs. No significant changes in 

RMP were seen in response to control ACSF or a lower dose of TGOT (0.2 µM), showing a dose 

dependent effect. Interestingly, a possible sex difference was indicated in the non-normalized 

antipeak RMP analysis of 0.2 µM TGOT, but not in the normalized analysis.  A significant 

difference between sex was not detected elsewhere in any of our analyses. Thus, the 

preponderance of evidence suggests that RMP is not regulated by OXT in a sex-specific fashion, 

largely suggesting that the sexually differential behavior exhibited in social play is not 

modulated in this specific mechanism but exists elsewhere. Overall, the data provided validates 

one area of our hypothesis in which OXTR activation of MSNs in the NAc modulate 

electrophysiological properties by demonstrating a depolarizing response. However this response 

does not differ by sex, which invalidates part of our hypothesis, but provides valuable insight.  

Our experiment was designed to test the influence of OXTR activation on the RMP. OXT 

is structurally similar to vasopressin (AVP) and can potentially bind and activate vasopressin 

receptors (AVPR) (Anacker et al., 2016; Bous et al., 2023; Chini et al., 2008; Rae et al., 2022; 

Sala et al., 2011; Song et al., 2014). Therefore, the OXTR selective agonist TGOT was used in 

our experiment instead of OXT to avoid any possible confounding effects. Other studies 

investigating similar electrophysiological properties have demonstrated an increase in neuronal 

excitability in response to TGOT and/or OXT in other brain regions, including the neurons in the 

endopiriform nucleus (EPN) and CA2 hippocampal neurons in male and female mice (Biggs & 

https://www.zotero.org/google-docs/?UGmzeo
https://www.zotero.org/google-docs/?UGmzeo
https://www.zotero.org/google-docs/?nquJsu
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Hammock, 2022; Tirko et al., 2018). There are several explanations for this mechanism. For 

example, in gonadotropin-releasing hormone (GnRH)-positive immortalized GN11 murine cells, 

OXTR activation is associated with an inhibition of inward rectifying potassium channels, which 

lead to depolarization and decreased potassium conductance across the membrane (Gravati et al., 

2010). Thus, one possibility of OXTR electrophysiological modulation of MSN RMP is through 

the inhibition of a membrane spanning potassium ion channel, such as an inward rectifying 

potassium channel. Leak sodium channels also can contribute to membrane potential. In the CA2 

pyramidal neurons of male and female mice, an inward tetrodotoxin-resistant (TTX-R) sodium 

current was identified and found to be activated by OXTR activation, promoting neuron 

excitability (Liu et al., 2022). Thus, it is likely an ionic mechanism is influencing changes in 

RMP excitability in response to OXTR activation, given that RMP is maintained by sodium and 

potassium leak channels (Chrysafides et al., 2024).  These two hypotheses could be tested by 

directly targeting these ion channels via voltage clamp coupled with the appropriate agonists 

and/or antagonists. For example, OXTR activation may decrease the magnitude of potassium 

currents and/or conversely increase the magnitude of sodium currents. Aside from ions, 

neurotransmitters such as glutamate can also influence excitability. Malenka and colleagues 

examined the effect of OXTR activation in the NAc in socially conditioned vs socially isolated 

male mice by measuring excitatory post synaptic currents (EPSCs) in the context of social 

reward. When glutamate is bound to α-amino-3-hydroxy-5-methyl-4-isoxazolepropionic acid 

(AMPA) receptors, an influx of sodium is sent into the synapse, influencing neuronal 

excitability. It was discovered that long term depression (LTD) of EPSCs was induced via 

OXTR activation when bound to OXT (Dölen et al., 2013). EPSC magnitude was decreased in 

slices from socially conditioned mice vs isolated mice, demonstrating mice with social 

https://www.zotero.org/google-docs/?nquJsu
https://www.zotero.org/google-docs/?z1NSn0
https://www.zotero.org/google-docs/?z1NSn0
https://www.zotero.org/google-docs/?GxpI46
https://www.zotero.org/google-docs/?ohQ4Ll
https://www.zotero.org/google-docs/?pEFSSh
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experience influence the generation of OXT-LTD. Glutamatergic circuits and OXT neuron firing 

have also been studied in association with the neural mechanisms underlying lactation (Leithead 

et al., 2021; Stern et al., 2000), revealing an increase of OXT release dependent upon 

glutamatergic transmission. Stern and colleagues investigated this further by investigating the 

EPSCs from identified OXT neurons in the supraoptic nuclei (SON) from adult virgin and 

lactating rats. They found that the frequency of MAPA-mediated miniature EPSCs (mEPSCs) 

more than doubled during lactation, suggesting an increase in membrane potential driven by 

glutamatergic inputs in response to OXT release. Thus, glutamatergic inputs and their close 

association with OXT firing could also be a likely mechanism for increasing excitability. We 

also note that NAc MSNs receive tonic GABAergic input (Ade et al., 2008), which could be 

another avenue by which OXTR activation could regulate RMP. 

Our experiment was also designed to investigate SABV to account for potential sex 

differences seen in social play. Our analyses did not detect a difference in sex, excluding analysis 

of non-normalized antipeak RMP in response to 0.2 µM TGOT application exposure. Given that 

this response was not seen elsewhere in our analyses, the preponderance of data points to no sex 

difference. Although no sex difference was uncovered using this particular methodology, it 

would be inaccurate to conclude that there is no sex difference in social play behavior at all. 

Rather, this result suggests the mechanism modulating sexually differentiated behavior in social 

play is elsewhere. This could mean a different neuromodulator, a different electrophysiological 

mechanism or in a different part of the relevant circuit. Regarding neuromodulators, a likely 

possibility would be AVP. AVP activates AVP and OXT receptors, and is heavily implicated in 

social behaviors (Bredewold & Veenema, 2018; Dumais & Veenema, 2016; Rae et al., 2022; 

Rigney et al., 2023). Regarding electrophysiological mechanisms, one likely target for 

https://www.zotero.org/google-docs/?dQiYvO
https://www.zotero.org/google-docs/?dQiYvO
https://www.zotero.org/google-docs/?EPDFw3
https://www.zotero.org/google-docs/?vppFpR
https://www.zotero.org/google-docs/?vppFpR
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investigation could be excitatory glutamatergic input, perhaps by assessing spontaneous 

excitatory postsynaptic currents.  Regarding other brain regions, one possibility is the lateral 

septum (LS). For example, in another study conducted on juvenile rats and social play behavior, 

OXT was injected into the lateral septum (LS) of the brain, which resulted in decreased social 

play behavior in females but not males (Bredewold et al., 2014). Other studies in rodents have 

also reported similar results, suggesting a reduction in pro-social behavior and an increase in 

anxiety is mediated by OXTRs in the LS (Beery et al., 2008; Beery & Zucker, 2010; Guzmán et 

al., 2013; Olazábal & Young, 2006). This demonstrates the complexity of the OXT system on 

sex-specific social behaviors, indicating that brain-region specific effects may be at play.  

Several limitations are presented in the data above. Our experiment only utilized 4 

controls with more males than females, and it would be important to increase this number and 

employ a balanced approach towards sex. Also, our experiments only employed a relatively 

restricted prepubertal age range. While this age range is justified due to the exhibition of 

abundant and sex-specific social play behaviors, it is possible that sex differences or other OXTR 

activation processes may differ across the prepubertal period or emerge post-puberty. One study 

in mice found exposure to OXT influenced the frequency of miniature excitatory postsynaptic 

currents (mEPSCs) in pyramidal neurons at different pre-pubertal age ranges (Zhang et al., 

2021). mEPSCs were found to be significantly increased around P10 and P14, however reduced 

at ages P22 and P28. So it may be plausible that the RMP response to OXT could differ by age 

even within the pre-puberty period. Additionally, our methodology only tested the effect of 

TGOT on OXTR to avoid possible confounding effects, however OXT itself was not utilized. 

Although exposure to both TGOT and OXT in other studies have demonstrated similar 

depolarizing effects (Biggs & Hammock, 2022; Liu et al., 2022; Tirko et al., 2018), this has not 

https://www.zotero.org/google-docs/?zYSDPA
https://www.zotero.org/google-docs/?Z5VKP8
https://www.zotero.org/google-docs/?Z5VKP8
https://www.zotero.org/google-docs/?tmJ9A1
https://www.zotero.org/google-docs/?tmJ9A1
https://www.zotero.org/google-docs/?R7Ha6l
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been investigated in the MSN of the NAc of rats and should be tested to accurately reflect 

physiological processes, even if it stimulates both AVP and OXT receptors. OXT signaling 

involves several brain regions and OXTRs have been found on other neurons expressing other 

neurotransmitters, for example, serotonergic neurons in the raphe nucleus (Biggs & Hammock, 

2022; Oubraim et al., 2023) Thus, indirect effects from other neurotransmitters should be 

considered in future experimentation.  

Ultimately, OXTR activation of MSNs in the NAc modulates electrophysiological 

properties of MSNs in the NAc, demonstrated by a depolarization in RMP in response to 1 µM 

TGOT. It is a fundamental first step to understanding how OXT regulates social behavior via the 

brain mesolimbic reward circuitry during the juvenile period. While this finding was not sex 

specific, it establishes the fact that the sex difference seen in social play is not found within our 

investigated mechanism and allows the potential exploration of another pathway. These crucial 

findings are the foundations for understanding how neurodevelopmental disorders are affected 

by social play behavior and expose the potential for more effective targeted therapeutic 

strategies.  
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CHAPTER 2 

The complex presentation of sex bias and omission in neuroscience research 

 

Research in this chapter will be submitted to a peer-reviewed journal:  

Liu, A., Vainorius, G., Hedrick, M., Dorris, D., Beeson, A.L.S., Fletcher, S., Crawford, A., 

Meitzen, J. (2024): The complex presentation of sex bias and omission in neuroscience research. 

In progress.  
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Abstract 

Despite known sex differences in the brain, behavior, and neurological disorders, 

neuroscience preclinical research has historically exhibited a sex bias, defined as male research 

models being favored over their female counterparts. In addition, neuroscience research has 

historically demonstrated sex omission, the lack of sex reporting. Here we extended previous 

studies by analyzing sex bias and omission in research articles published across six neuroscience 

journals in 2020. Regarding sex omission, 14% of articles did not report sex. Compared to 

previous years, sex omission appears to be declining. Regarding sex bias, 23% of articles used 

only males, while 5% utilized only females. Though 57% of the articles utilized both sexes, only 

17% of these considered sex as a biological variable (SABV). Compared to previous years, sex 

bias is moderating yet remains persistent. Sex bias and omission varied widely across research 

models. 34 different research model types were identified in the neuroscience literature. Most 

studies employed one type of research model, however 6.67% of articles employed more than 

one. The percentage of articles exhibiting multiple research models correlated strongly with the 

impact factor of the originating journal. Overall, these findings illustrate the complex and 

changing picture of sex bias and omission in neuroscience research. While sex bias and omission 

are declining compared to previous years, they remain persistent.   
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Introduction 

The underreporting of sex in neuroscience research has demonstrated a historical pattern 

of repetition in which sex bias and omission persist in literature. Sex bias is defined as a 

favoritism of one sex over another, a concept which neuroscience literature has continuously 

exhibited by utilizing male models over females (Beery & Zucker, 2011; Berkley, 1992; 

Mamlouk et al., 2020; Mogil & Chanda, 2005; Shansky & Woolley, 2016; Will et al., 2017; 

Woolley, 2021). Sex omission is defined as the absence of reporting research model sex when 

applicable. These concepts are not limited to neuroscience and extend into other biomedical 

fields (Kim et al., 2021; McCarthy, 2015; Potluri et al., 2017; Woitowich et al., 2020). Although 

single sex use may be justified in appropriate circumstances, the lack of justification in scientific 

literature has provoked significant discussion across various biomedical disciplines. As a result, 

new journal regulatory policies have been created to better support the scientific advancements 

of men and women (Clayton, 2018; Clayton & Collins, 2014).  

Understanding the changing complexity of sex bias and omission in neuroscience 

literature is crucial. Research articles are emphasized as they are essential as both an 

accumulation of previous findings and a foundation for new research and discovery. An initial 

comprehensive study of neuroscience literature examined articles published between 2010 and 

2014 utilizing only mice and rats (Will et al., 2017). In this analysis, sex omission decreased 

while sex bias remained persistent. While an increased amount of articles did report sex of 

models, sex was seldom considered an experimental variable. The most recent comprehensive 

analysis of neuroscience research articles examined studies published in 2017 (Mamlouk et al., 

2020). On January 25 2016, the implementation of the National Institute of Health (NIH) Sex as 

a Biological Variable (SABV) (NOT-OD-15-102) regulatory policy was placed (Clayton, 2018; 
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Clayton & Collins, 2014). Thus, NIH funded and non-NIH funded studies were analyzed to 

assess if sex bias and omission differed by funding status. Little evidence was found that NIH 

funding status influenced sex bias and omission. In this study, all research models utilized were 

considered for analysis. It was found sex bias and omission varied across research models. 

Across journals, sex omission varied though sex bias levels appeared similar. Although more 

than half of analyzed articles utilized both male and female models, only a comparatively few 

considered SABV.  

The persistence of sex omission and bias across journals even after the advent of 

regulatory policies addresses a challenge for sex-specific scientific and biomedical progression. 

As the most recent data available in regards to sex bias and omission in neuroscientific literature 

dates back to 2017, there has since been a lack of data. Here we expand on this knowledge by 

assessing sex bias and omission in neuroscience research articles published in 2020 across six 

journals: Journal of Neuroscience, Journal of Neurophysiology, Science, Neuron, Nature and 

Nature Neuroscience. These journals were selected given their significance within the 

neuroscience field and to align with previous studies (Mamlouk et al., 2020; Will et al., 2017). 

Articles with multiple models were analyzed against journal impact factor. Sex bias and 

omission were assessed in the context of research model and journal.  
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Methods and Materials 

Article inclusion criteria and analysis 

Methods for research article inclusion and analysis follow those previously published 

(Mamlouk et al., 2020; Will et al., 2017). Briefly, research articles published in the year 2020 

were analyzed from the following journals: Journal of Neuroscience, Journal of 

Neurophysiology, Science, Neuron, Nature, and Nature Neuroscience. 8 trained curators (5 

female, 3 male) analyzed all published research articles in these journals within 2020 to 

minimize sampling bias. Trained curators were employed because the divergent and extensive 

vocabulary used to describe animal sex and its treatment as an experimental variable make 

automated text mining approaches challenging. Inter-curator reliability was evaluated as in 

previous studies (Will et al., 2017; Mamlouk et al. 2020).  Curators first determined whether an 

article was a primary research article. Reviews, editorials and non-primary research articles were 

excluded from further analysis. Research articles were then assessed for neuroscience relevance 

using a broad inclusion criterion. Articles originating from the Journal of Neurophysiology, 

Journal of Neuroscience, Neuron and Nature Neuroscience were automatically accepted as 

neuroscience relevant. Articles from Nature and Science were accepted if the article topic 

encompassed any aspect of the nervous system, ranging from the molecular to behavioral level 

of analysis.  

Research model coding 

Articles were then coded for species or research model. Research models represented in 

the overall data set were categorized as follows: amphibia (including X. laevis, salamanders, 

other frogs), aplysia, C. elegans, cats, crabs, drosophila, ferrets, fish: other (including goldfish, 

electric fish, lampreys, other fish), gerbils, guinea pigs, humans, immortalized cell lines, in silico 
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models, insects: other (including bumblebees, cockroaches, locusts, crickets, mosquitos), 

invertebrates: other (including leeches, oysters, lobsters), mammals: other (including dogs, pigs, 

bats), mice, non-human primates (including marmosets, chimpanzees, monkeys), non-oscine 

birds (including chickens, owls, pigeons), oscine birds (including finches, sparrows, crows), 

rabbits, rats, reptilia (including turtles, bearded dragons), rodents: other (including ferrets, 

chinchillas), zebrafish. “Other” categories were implemented with the purpose of grouping 

species with little representation. Articles using primary cell cultures or embryonic animals were 

categorized with species of origin, following previous studies (Will et al., 2017; Mamlouk et al. 

2020). Articles using immortalized cell lines were coded as an individual research model, 

immortalized cell lines, following previous studies.  Immortalized cell lines were categorized as 

a unique model system given that this research model exhibits common aspects that are shared 

across origin species. Articles using purely computational and/or mathematical models with no 

originative use of model organisms were categorized as in silico. Multiple species used within 

one article were each analyzed individually.  This protocol thus organized the articles into a pool 

of 2,167 entries categorized by research model.  

Article entry analysis 

Article entries were then analyzed for biological sex. Sex categories included: male, 

female, male and female wherein biological sex was considered an experimental variable, male 

and female wherein biological was not considered an experiment variable, sex not reported and 

hermaphrodite. Following a broad inclusion paradigm, articles were considered to have 

addressed SABV if any formal statistical comparison of assertion of such a comparison of males 

and females was performed, including the use of sex as a covariate, whether the data or analysis 

was shown or not shown, and also including whether sex differences were detected or not. No 
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articles reported data disaggregated by sex but did not perform or assert to have performed a 

statistical comparison. When distinct experiments within an article differentially reported sex in 

the same research model, articles were coded using the most descriptive experiment. For 

example, if one experiment did not report sex in mice, while another experiment reported using 

combined male and female mice, then the article was coded as “mice: male and female wherein 

biological was not considered an experiment variable.”  When distinct experiment within an 

article solely employed different sexes, then articles were coded male/female, biological sex not 

considered, following previous studies (Beery and Zucker, 2011; Will et al., 2017; Mamlouk et 

al. 2020).  Data was analyzed via linear regression and chi-squared test (Prism version 9.5.1, 

Graphpad Software). P values <0.05 were considered as significant.  
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Results 

Qualities of neuroscience articles published in 2020  

Articles were obtained from six neuroscience journals of varying impact factor: The 

Journal of Neuroscience, Neuron, Nature, Nature Neuroscience, Science, and The Journal of 

Neurophysiology.  Each journal contributed a different number of articles to the analyzed pool, 

with The Journal of Neuroscience contributing the greatest (46.60%), subordinated by The 

Journal of Neurophysiology (19.71%), Neuron (13.729%), Nature (7.86%), Nature Neuroscience 

(6.92%) and Science (5.12%) (Figure 2.1A). A wide range of research models were employed 

across all research articles (Figure 2.1B). Mice were the most prevalent model (39.68%), 

followed by humans (26.51%), rats (11.10%), and non-human primates (7.05%). The remaining 

15.66 % of articles spanned 21 other research model classifications 

 

Figure 2.1. Journal article total and research model in journals published in 2020. A) Journal article total. J. 

Neuroscience contributes the largest proportions of articles, while science contributes the least. B) Research model 

total. Mice, rats and humans made up the top 3 models employed.  
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Select articles employed more than one model classification 

6.67% of articles employed more than one model classification (Figure 2.3A). These 

articles featured numerous combinations of models (Figure 2.3B). The most common model 

combinations were humans and mice (29.91%), followed by rats and mice (17.76%), and 

immortalized cell lines and mice (12.15%). The percentage of articles employing more than one 

model correlated significantly with the 2020 journal impact factor (Figure 2.2)(r2= 0.8694,  p= 

0.0067), with Nature (impact factor 49.96, 17.46% employing more than one model) and Science 

(impact factor 47.72, 13.41% employing more than one model) showing the highest percentage 

of multi-model articles.  

 

Figure 2.2. Percent of multi-model neuroscience articles published in 2020 correlated significantly with 2020 

impact factor. Nature and Science had the most amount of multi-model use.  
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Figure 2.3. Some journal articles employed more than one model in their study. A) Single vs multiple model article 

totals. Most articles in 2020 employed only one model in their research. B) Model combinations across articles that 

employed multiple models. Humans and mice were the most popular combination utilized.  
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Sex bias and omission continue to decline but are still evident in neuroscience studies  

Articles were classified as employing only males, only females, males and females 

without consideration of sex as an experimental variable, males and females with consideration 

of sex as an experimental variable, hermaphrodites, or not reporting sex (Figure 2.4A). Articles 

utilizing males and females without consideration of sex as an experimental variable represented 

47.35% of total articles, followed by male only (23.49%), sex not reported (13.87%), males and 

females with sex considered as an experimental variable (9.81%), female only (4.68%) and 

hermaphrodites (0.81%). Compared to articles published in 2017, the percentage of articles 

employing males and females without consideration of SABV continues to climb from ~44% to 

~47% and remains the largest proportion of the neuroscience literature. Sex bias remained 

present, with more articles featuring only males compared to only females, similar to 2017 (male 

only ~26%, female only ~5%). Overall sex omission declined compared to 2017, dropping from 

~16% to ~14%. While sex appears to be widely acknowledged given the dataset, the number of 

articles considering sex as an experimental variable is relatively small (9.81%), though 

increasing from 2017 (8%). This lack of employing sex as an experimental variable is 

highlighted when directly comparing articles employing male and females. Of these articles, 

approximately 83% did not include sex as an experimental variable when compared to the ~17% 

of articles that did incorporate sex as an experimental variable (Figure 2.4B). These analyses 

indicate that overall sex bias and omission continues to decline, while still remaining persistent 

and complex.  
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Figure 2.4. Distribution of sex bias and omission in neuroscience articles published in 2020. A) The majority of 

studies reported sex in their methodology, however sex is largely not considered. Male models are employed in 

frequently than females. B) Within the proportion of articles that employed male and female models, SABV is not 

widely demonstrated.  

Research model influences sex bias and omission  

Research models varied in every aspect of sex bias and omission (Figure 2.5), including 

the representation of articles which utilized only male models (𝜒2 = 1227, p < 0.001), only female 
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models (𝜒2 = 543.7, p < 0.00), hermaphrodites (𝜒2 = 1395, p < 0.001), the proportion which did 

not consider sex as an experimental variable (𝜒2 = 601.1, p < 0.001), did consider sex as an 

experimental variable (𝜒2 = 271.2, p < 0.001) and did not report sex at all (𝜒2 = 922.9,  p < 0.001) 

(Figure 2.5A). When examining the top three most commonly employed research models, this 

diversity is emphasized (Figure 2.5B). Mice were the most commonly used species, with 

approximately 40% of articles utilizing this model. Of these, only 13% considered sex as an 

experimental variable when using male and females while 50% did not consider sex as an 

experimental variable when using male and females. Approximately 26% used only males, 2% 

used only females and 9% did not report sex. Following mice were humans, comprising about 

27% of articles. When employing both male and females, 71% of human articles did not consider 

sex as an experimental variable while 10% did consider sex as an experimental variable. 7% used 

males only, 0.5% used females only and 11% did not report sex at all. Rounding out the top three 

research models were rats, being employed by 11% of articles. Rat articles exhibited a different 

pattern, with 26% of articles using both male and female rats did not consider sex as an 

experimental variable and 8% of rat articles using both sexes did consider sex as an experimental 

variable. 52% used males only, 9% females only, and 6% did not report sex.  

Beyond the most commonly used research models, sex bias and omission widely 

diverged.  In regards to sex bias, one extreme highlights the favoritism of one sex over another. 

For example, crabs feature 100% use of males, followed by oscine birds (75% of males).  The 

opposite extreme is also present, with animals such as ferrets and rabbits featuring increased 

female use compared to other research models (57% and 40% female respectively). Importantly, 

scientific justifications in usage of one sex or another can be provided regarding certain models 

and experimental goals. In the most commonly employed oscine songbird model, the zebra finch, 
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only males typically exhibit song behavior and the associated neural substrate, and thus these 

studies normally employ male only models (Nixdorf-Bergweiler, 2001; Wade, 2001; Wade & 

Arnold, 2004). In genetic disorders, males may be utilized to study X-linked disorders due to 

only possessing one X chromosome, unlike females (Gilbert et al., 2020). On the other hand, it 

would be logical to use only female models to assess processes such as reproduction (Proaño & 

Meitzen, 2020; F. Wang et al., 2020). Between these extremes are research models featuring 

widespread integration of male and female usage, such as humans (71%), and gerbils 

(75%).  With regards to sex omission, select research models largely fail or neglect to report sex, 

including immortalized cell lines (89%), aplysia (100%) and reptilia (100%). Meanwhile, other 

research models such as cats, non-human primates, and amphibia exhibited little to no sex 

omission. Taken in total, this analysis indicates that variation was wide in regards to sex bias and 

omission across research models, consistent with previous analyses of prior literature (Beery and 

Zucker, 2011; Mamlouk et al., 2020, Will et al., 2017). 
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Figure 2.5. Sex bias and omission vary greatly across research models. A) All research models. Models were coded 

into appropriate model categories, showing great variation in employment in regards to sex. B) Top Three Utilized 

Models. This including mice, humans and rats. Sex reporting across top 3 models also vary.  

 Sex omission but not bias varies by journal  

Thus far, sex bias and omission analyses have been analyzed independent of article 

journals. Previous studies of sex bias and omission have documented differences in sex bias and 

omission between scientific journals (Beery & Zucker, 2011; Mamlouk et al., 2020; Potluri et al., 

2017; Will et al., 2017; Woitowich et al., 2020). Therefore, articles were analyzed by journal to 

assess whether variability in sex reporting continued across journals (Figure 2.6). When 

reporting sex bias, journals varied in the proportion of articles that reported males and females 
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without considering sex an experimental variable (𝜒2 = 12.51, p = 0.0284). The Journal of 

Neuroscience reported the highest percentage of male and female employment with sex not 

considered as an experimental variable (52%), followed by Journal of Neurophysiology (49%), 

Neuron (41%), Nature Neuroscience (41%), Nature (39%) and Science (23%). There were no 

differences between the proportion of articles that utilized male and female models and 

considered sex as an experimental variable ( (𝜒2 = 6.500, p = 0.2606), and the usage of males 

only ( (𝜒2 = 1.864, p = 0.8677), females only  (𝜒2 = 6.250, p = 0.2826), or hermaphrodites  (𝜒2 = 

8.000, p = 0.1562). Sex bias thus appeared similar across all journals, with an average of 24% 

favoring male models over females. In regards to sex omission, the proportion of articles that did 

not report sex varied by journal  (𝜒2 = 14.42, p = 0.0131). Science exhibited the highest levels of 

sex omission (37%), followed by Nature (21%), Neuron (18%), Nature Neuroscience (16%), 

Journal of Neurophysiology (12.34%) and Journal of Neuroscience (9%).  Sex omission does not 

correlate with the number of articles published by that journal in 2020 (r2  =0.4601, p=0.3186). 

 

Figure 2.6. Sex omission but not bias varies by journal. Sex reporting varies between journals. Across all journals, 

male models are always employed more than their female counterparts. 
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Discussion 

The key finding of this study is that while sex bias and omission is declining in 

neuroscience research literature, it continues to persist. However, there is no simple 

generalization that can easily illustrate the complex presentation of sex bias and omission within 

this literature review. While a little over half of total articles (57.08%) utilized both sexes in their 

experiments, only about 10% considered SABV. This finding reveals that while a majority of 

neuroscience articles are employing both female and male research models, SABV is still not 

widely considered. Meanwhile, 14% of articles did not report the sex of their research model. 

This is further complicated by the variation of sex bias and omission between journal and 

research model. Additionally, some articles utilized more than one research model. The 

correlation between multi-model species articles and journal impact factor note the elaborate 

relationship between model utilization and journal.  

Approximately 14% of neuroscience research articles published in 2020 did not report 

research model sex. However a comparison across time is crucial to fully assess the rate and 

intensity of sex omission in neuroscience research literature. Previous studies executed by our 

research group with nearly identical methodology investigated SABV in neuroscience research 

articles within the same 6 journals between 2010 and 2017 (Mamlouk et al., 2020; Will et al., 

2017). The difference in methodology between the studies is that Will and colleagues limited 

their analysis to assessing only mice and rats. However, it is still critical to assess sex omission 

across these models and combining this previous data with the current study allows for a 

thorough understanding of sex omission overtime (Figure 2.7). Will and colleagues found about 

47.1% of assessed articles did not report sex in 2010, similar to other investigations of 

neuroscience literature within that general timeframe (Beery & Zucker, 2011; Shansky & 

https://www.zotero.org/google-docs/?wXumRY
https://www.zotero.org/google-docs/?wXumRY
https://www.zotero.org/google-docs/?M0Ejpo
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Woolley, 2016). The rate of sex omission eventually decreased to 16.6% in 2013, 10.3% in 2017 

and 8.2% in 2020 from our current study. Thus, while sex omission is improving, it still persists.  

 

Figure 2.7. Analysis of mice and rats across time, from 2010 – 2020. Sex bias remains relatively the same since 

2010, but sex omission improves across time.  

A more recent study from our research group utilizing identical methodology to this 

current study assessed SABV in neuroscience research articles published in 2017 within the 

same 6 journals in all research models (Mamlouk et al., 2020). When analyzing across all 

research models, in 2017, it was found that 16.3% of articles did not report research model sex. 

In 2020, sex omission decreased to about 13.9%, revealing a continuing marginal improvement 

in sex reporting (Figure 2.8). Thus, overtime, sex omission appeared to decrease, which is 

consistent with the finding of another study that employed a different methodology (Woitowich 

et al., 2020). This attenuation of sex omission appears encouraging. However, there is a major 

point of concern. Our analysis revealed that sex omission can vary widely among research 

models. For some models, it seems reasonable that sex would not be as widely reported, such as 

studies that work with juvenile zebrafish where sex is not readily assessed across the sometimes 

hundreds of subjects (Harmon et al., 2020; Liew & Orbán, 2014; Ma et al., 2020; E. T. Smith et 

https://www.zotero.org/google-docs/?M0Ejpo
https://www.zotero.org/google-docs/?M0Ejpo
https://www.zotero.org/google-docs/?aAsaa7
https://www.zotero.org/google-docs/?eWm2lu
https://www.zotero.org/google-docs/?eWm2lu
https://www.zotero.org/google-docs/?ObXtZg
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al., 2020; Wilson et al., 2014). For other models, it is easier to report sex and it is surprising that 

sex omission remains high. For example, our study found that articles using cell lines or primary 

cell cultures as their research model widely do not report sex, which is consistent with previous 

work from multiple groups (Kim et al., 2021; Mamlouk et al., 2020; Shah et al., 2014). 

Interestingly, sex omission is widespread in computational neuroscience projects classified by 

this study as in silico. At first glance, it perhaps seems rational that these studies would not 

report sex. However, depending upon how the studies are designed and how the source data is 

collected, processed and labeled, omission could inadvertently introduce significant 

consequences. The lack of sex reporting in these types of models contribute to the persistence of 

sex omission, attenuating the progress made in this domain.  

Sex bias remained persistent in 2020, with the utilization of male research models more 

than triple the percentage of their female counterparts across all research models (Figure 2.8). By 

employing data from previous studies focused upon mice and rats, we can draw conclusions 

regarding the persistence of sex bias across time, similar to our approach regarding sex omission. 

In mice and rats, sex bias has remained largely constant since 2010 (Figure 2.7).  In 2010, 

approximately 31.1% of articles only studied males and this percentage increased to 39.3% in 

2013. This proportion later decreased to 36.3% in 2017 and then to 31.3% in 2020. The 

proportion of articles exclusively utilizing female mice and rats also fluctuated in that time 

period. 4.6% of studies used females only in 2010. This proportion increased to 6.4% in 2013 

however decreased in 2017 to 4.6% and continued to decline to 3.8% in 2020. In all research 

models, the exclusive utilization of only male models decreased from 2017 to 2020, from 26% to 

23.5% respectively. However, exclusive utilization of female only models was relatively the 

same. In 2017, 4.9% of articles used only females and this percentage very slightly decreased to 

https://www.zotero.org/google-docs/?ObXtZg
https://www.zotero.org/google-docs/?1Q1xgj
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4.7% in 2020. Complementing these data, the proportion of articles that employed both males 

and females regardless of SABV grew from 17.2% in 2010, to 37.7% in 2013, to 48.8% in 2017 

and 56.6% in 2020 (Figure 2.8).  

 

Figure 2.8. Sex bias and omission across all research models in 2017 vs. 2020. Sex bias and omission marginally 

improve. Since 2017, the proportion of articles that consider SABV has also improved.  

The presentation of sex bias across the years despite policies implemented in 2016 by the 

National Institute of Health (NIH) requiring sex to be considered a biological variable is 
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disconcerting (Clayton, 2018; Clayton & Collins, 2014). With the intentions of equal 

representation for both male and female models in vertebrate research, there would be 

expectations of sex bias significantly declining with the inclusion of sex based analyses. 

However, this is not the case. The proportions of male and female only models employed for 

experimentation have remained relatively stagnant overtime. The exception to this would be 

single sex studies with proper justification. However, the inclusion of a justification is not 

regulated and is up to the discretion of the author. The lack of a standard justification protocol 

allows for inappropriate variability in sex reporting and representation, such as excluding the 

usage of female models due to sex differences in behavior, anatomy and physiology (Bramson et 

al., 2020; Shimojo et al., 2020; G. Smith et al., 2020; B.A. Wang et al., 2020). This undermines 

the importance of SABV in regards to scientific progression given the substantiated sex 

differences between male and female biological and molecular processes. The 

underrepresentation of females in research is a problem, as half of the population is not 

accounted for. This lack of representation may not accurately reflect scientific findings as they 

would not account for possible sex differences. Additionally, only studying male models and 

comparing females to that standard neglects female specific processes such as reproduction, 

pregnancy and other hormonal related processes such as hormonal contraception and menopause 

(Galea et al., 2023; Puri et al., 2023).  

This temporal analysis presents a complex picture of sex bias. One piece of this picture is 

the evident greater frequency in which males are utilized over females across all years 

sampled.  Thus it would be easy to conclude that sex bias persists in neuroscience preclinical 

research.  Countering this simple explanation is the increase in manuscripts employing both 

males and females, which has substantially increased across all years sampled.  This finding 

https://www.zotero.org/google-docs/?GPx1Lt
https://www.zotero.org/google-docs/?7LnMOr
https://www.zotero.org/google-docs/?7LnMOr
https://www.zotero.org/google-docs/?PwkNou
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argues that sex bias is diminishing, as both females and males are increasingly employed in 

research studies. This is an encouraging finding, however, it masks a somewhat surprising 

complication: that sex is widely neglected as an experimental variable, even in studies that utilize 

both males and females.  

Again examining the available longitudinal data that focuses on mice and rats (Figure 

2.7), the percentage of articles using male and females without considering SABV increased 

from 12.9% in 2010 to 32.4% in 2013. This further increased to 40.8% in 2017 and reached 

44.9% in 2020. When considering all research models, there is an increase from 44.3% in 2017 

to 47.4% in 2020. Thus, by 2020, roughly half of the sampled research studies employed both 

males and females but did not test whether sex impacted the gathered data (Figure 2.8).  

For our studies, a broad definition of employment SABV was employed, and we are thus 

presenting the most optimistic representation possible. Any assessment of sex, whether a sex 

difference was detected or not, was considered as incorporating SABV. Under these 

methodological considerations, we detected a relatively small but growing population of articles 

evaluating SABV. SABV in rats and mice showed an upward trend overtime from 4.3% in 2010 

to 5.3% in 2013. This trend persists with an increase from 8.1% in 2017 to 11.7% in 2020. 

Considering all research models, a similar marginal increase is observed, with a percentage of 

7.7% in 2017 rising to 9.9% in 2020.   

Overall, these findings are encouraging, since more studies are employing males and 

females and incorporating sex as part of their data analytic pipeline. However, we must 

acknowledge that a great potential for growth remains. Despite the increase of articles using 

male and female models in research, sex-based analyses are still being overlooked. The 

exclusion of SABV applies to a diverse variety of biomedical fields and is not just a concept 
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localized to neuroscience (Beery, 2018; Yoon et al., 2014). This is evident with specialties such 

as immunology, physiology, and endocrinology lacking a significant increase in sex-based 

assessments since previous analyses in 2009 (Woitowich et al., 2020). This overlook assumes 

that SABV is the bare minimum and is not worth pursuing further, which is far from the truth. 

The discovery of sex differences for a given trait allows for the optimal development of 

biomedical advancements, drug therapies, or other health and medical benefits of both sexes 

(Yang et al., 2019). Simply reporting for sex does not allow the uncovering of sex differences 

and further prompts the reader to possibly incorrectly assume there were none or that these 

differences have yet to be found.  

The data presented in this study can be perceived as optimistic given the decline in sex 

omission alongside the increased inclusion of both male and female models in neuroscience 

research. Both of these findings have continued to trend upward since our first comparative 

analysis in 2010 and again in 2017, indicating more researchers are considering to report sex or 

utilize it as a biological variable (Mamlouk et al., 2020; Will et al., 2017). However, this 

optimism is tempered by several points.  

First, the amelioration in regards to sex omission and SABV are marginal at best, 

consistent with other studies that report similar results (Rechlin et al., 2021). Since our last full 

research model assessment in 2017, sex omission has only decreased approximately 3%. 

Although more researchers are incorporating both male and females in their studies, there has 

only been an approximate 2% increase since 2017 in regards to sex being considered as a 

biological variable. This highlights the second point of concern, in which sex is still widely not 

being addressed as a biological variable despite the increased utilization of both sexes for 

neuroscience research purposes. In 2017, 44% of studies employing both male and females did 

https://www.zotero.org/google-docs/?52y9YR
https://www.zotero.org/google-docs/?IDeQHo
https://www.zotero.org/google-docs/?uI76I2
https://www.zotero.org/google-docs/?b7a030
https://www.zotero.org/google-docs/?FYUgZE
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not consider SABV and this increased to 47% in 2020. Lastly, sex bias has continued to persist 

with only 4% of articles using female only models since 2017. While there is a 2% decrease in 

male only model incorporation since 2017, this decline is quite unimpressive.  

The findings above are problematic and can be remedied in several ways. While sex does 

not have to be assessed in every study, researchers must incorporate rationale to justify their 

methodology in regards to sex omission, same sex reporting or the exclusion of sex-based 

analysis. Doing so allows the furthering of scientific discovery in several ways. At the very least, 

the reporting of sex provides a method for reproducibility of a scientific finding and thus should 

always be reported if applicable. If only one sex is utilized for sex-specific behaviors, 

physiological processes, or anatomical features, appropriate justification must be provided. Some 

studies have reported research articles that study one sex to limit experimental variability (Beery, 

2018; Prendergast et al., 2014). This bluntly can be considered negligent and unwise, as this 

reasoning straightforwardly ignores the diversity of male and female processes. Otherwise, a lack 

of justification would give the assumption that the research methods and findings may be 

applicable to both sexes, which may not be accurate or appropriate as it disregards possible sex 

differences. Additionally, to ignore SABV is to discount established sex differences and the 

potential to uncover new sex difference findings. Across the nervous system, sex differences 

have been studied and suspected to influence multiple disorders, including neurodevelopmental, 

neurodegenerative, autoimmune and affective disorders (Bangasser & Valentino, 2014; Gold et 

al., 2019; Zagni et al., 2016). These disorders are known to affect males and females 

disproportionately and possibilities for optimal health preventatives or therapeutic strategies are 

limited without first investigating SABV.   

https://www.zotero.org/google-docs/?Av0OzG
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Even if no sex difference is detected, the knowledge obtained is crucial and can be used 

to further improve hypotheses, adjust methodologies or better distribute resources. An example 

of this is presented in the first chapter of my thesis, where it was discovered there is no sex 

difference regarding the change in resting membrane potential in response to oxytocin receptor 

activation. This finding indicates the sexually differentiated behavior seen in social play is 

influenced by another biological property, allowing the invalidation of our initial hypothesis. 

This discovery informs us that there needs to be further investigation done to better understand 

social play behavior and the associated sexually differentiated behavior. Therefore, properly 

assessing SABVfacilitates efficient scientific advancement, allowing appropriate measures to be 

taken to further optimize the understanding and preservation of our health.  
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Appendix A 

Relevant Protocols 

Data analysis protocol for electrophysiology, including assessing resting membrane potential. 

This is the standard protocol employed by the Meitzen laboratory. It is not original to me and 

has been developed by many individuals over the years.   I include it in my thesis so that the 

protocol is archived and to best document the data analysis methods. 

Data Analysis Software: 

 Clampfit Download: Clampfit 10.6.2 or pClamp Website 

 MiniAnalysis Download: Demo Form or Demo Download 

Data Analysis Protocol: 

1. Start analyzing data by first analyzing the negative current step files. Open the 

corresponding negative step pClamp files in Clampfit.  

2. Average the files together by using the average files function in Clampfit. On the menu 

bar select Analyze>Average Files. Select all of the negative step files and hit OK. This 

will generate a new average file.  

3. Close the negative step files but make sure to leave open the average file that you just 

created. 

http://mdc.custhelp.com/euf/assets/content/pCLAMP_10_6_2.exe
http://mdc.custhelp.com/app/answers/detail/a_id/18779
http://www.synaptosoft.com/MiniAnalysis/DownloadDemo.html
http://www.synaptosoft.com/MiniAnalysis/DownloadDemo.html
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4. In the average file, we will start our analysis 

with first finding the baseline R1S1 mean in mV. Place cursor 1 near the beginning of 

the traces and then place cursor 2 at least 0.2 s away from cursor 1, but before the trace 

starts to deflect due to injected current. Run a statistical mean of all the traces between 

cursor 1 and 2 by using the statistical analysis in Clampfit. It is found on the menu bar by 

selecting Analyze>Statistics. The Set-up of the analysis should resemble above.  

5. After hitting OK in the window from above, the results will be in the Results sheet in 

Clampfit. Copy out the R1S1 Mean column and paste the results into the Baseline R1S1 

column in the neuron’s spreadsheet. 

a. To clear the Results sheet: Select Edit>Clear Sheet>OK.  

6. To measure the steady state R1S1 mean, move the cursors to span a range within the 

step function. Place the cursors at least 0.2 s apart so that they rest on a steady portion of 

the traces and are before the input current is turned off. Try to find a region in which the -

0.02 nA current trace is the most stable. 

7. Repeat the statistical analysis from the step 4 and copy out the Mean R1S1 column and 

paste the results into the Baseline Steady State R1S1 column in the neuron’s sheet. If the 

equations from the previous neuron were successfully copied over then the Input 

Resistance (IR) should have been automatically calculated. If not copy over the 

equations from another sheet. 

8. Find the Lowest Steady R1S1 by selecting the final trace recorded using the > key. The 

trace should now be highlighted in red. Drag cursor 1 over the initial deflection due to 

injected current and determine the lowest voltage achieved within 0.2 sec of current 

injection. Record this value as the Lowest Steady R1S1 in the neuron’s sheet. The sheet 

will automatically calculate the Sag Index.  

9. Now it is time to find Tau. Place cursor 1 at the point where the trace starts to 

exponentially deflect back to the baseline. Place cursor 2 at a distance 0.1 sec to the right 

of cursor 1. Run an exponential line fit between the two cursors for all the traces. You 
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will find the fit function on the menu bar Analyze>Fit and your fit should resemble 

below.  

10. In the Results window in Clampfit copy out the Tau column and paste it in the Tau 

column in the neuron’s sheet. The sheet will automatically calculate the Capacitance for 

the input resistance of .01 and 0.2 nA. If not you can copy the equations over from 

another sheet. 

11. The sheet should automatically calculate out the RRIR, Inward Rectification and % 

Inward Rectification.  

12. Open the positive current step files in Clampfit. For each file you will need to fill in the 

data corresponding to the frequency curves in the neuron’s excel spreadsheet. Visualize 

individual traces by menu bar View>Select Sweeps>Select Sweep #1>OK. Click through 

sweeps using < / > keys until the sweep containing the first spike is located. Enter 0 in the 

excel spreadsheet for the number of spikes for all previous sweeps. Move cursor 1 just to 

the left of the initial deflection. Move cursor 2 just to the right of the deflection back to 

baseline.  

13. In the top menu bar, click on “Event Detection.” Then select “Threshold Search.” Move 

the Baseline cursor (0) to some point below threshold. Move the Trigger cursor (2) to 

some point after threshold. Select positive-going traces. De-select Pretrigger and Post-

trigger lengths if selected. Select active signal, active trace, and cursors 1..2 search 

regions. Click OK.  
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14. Close the Event Viewer window that opens. You should now have a new 

threshold detection toolbar.  

 

15. Click the “Non-stop”  button. Then click the “Process selection”  

button. A window should pop up containing the number of action potentials present in the sweep. 

Enter this number as the number of spikes in the excel spreadsheet. Click OK.  
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16. Click to the next sweep using the > key. Repeat the analysis by first 

clicking the “Restart”  button and selecting “Yes” to “Delete existing data before restarting?” 

Then, repeat steps 15-16 until all sweeps have been quantified.  

17. After that visually count the number of Spikes at each input current step 

and place the counts in the neuron’s sheet. Scroll through sweeps using the > key. You can 

double check the input waveform and make sure that your input current steps are correct by 

menu bar View>Stimulus Waveform Display. Zoom in on the waveform and you can verify the 

pA steps. A 10 pA step corresponds to a .01 nA change in the input na column in the sheet. 

18. For each of the FI Slope calculations, change the equation so that it is on 

the linear range of the slope. The green and red boxes should correspond to the current and 

frequency which elicited the first spike(s). The purple and blue boxes should correspond to the 

current and frequency at which the number of spikes begins to repeat.   

19. For the Rheobase calculation, move the boxes so that the equation 

calculates the average of the input current which elicited the first spike(s) for each file.  

20. Now we characterize the first action potential of each positive step file.  

21. Isolate the first sweep with action potentials using the < / > keys.  

22. To find the Threshold of the first Action Potential bring cursor 1 and 2 

and put them on either side of the AP respectively. In the trace window hit the arithmetic button 
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 and it should bring up a window as below.

 
23. Hit the Add Traces button to add one trace. Modify the equation in the 

Expression field to include the number of the trace you just added at the beginning and the 

number of the trace with the AP inside the ( ). Make sure the region to analyze is set to Cursors 1 

and 2. Hit OK and the program will revert to all the traces visible again. Select the sweep with 

the first APs and the sweep that you added using View>Select Sweeps. Use the Ctrl key to select 

both at once. Bring cursors 1 and 2 closer in toward the AP then export the data using on the 

menu bar Edit>Transfer Traces and the window below will open. 

24. Hit the Select button and select all visible signals and then select the two 

traces you have been working with from the list.  

 

 

 

25. Hit OK in both windows then go to the Results window. You will see 

three columns one labeled Time and the others labeled with the number of the traces you have 

been working with. Look in the column corresponding to the added trace where you ran the 

double differential. Find the point in the column where the value is equal to three times the 
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standard deviation with a visual search. Once you have found that point, copy the corresponding 

point from the second column where values for the other trace are listed. That value represents 

the threshold for that AP in mV. Place that value in the neuron’s sheet in the appropriate column 

in the threshold analysis section of the sheet. 

26. Find the sweep with the AP being analyzed. Right click “Time (ms)” on 

the bottom of the screen and click “Properties.” Then in the drop down menu, select 

“milliseconds.”  

27. Place cursor 1 before the first action potential and cursor 2 after the first 

action potential such that the cursors contain the full action potential, including the AHP.  

 

28. In the top menu bar, click on “Event Detection” and then “Threshold 

Search.” In the “Level marker (0)” field, input the threshold value that you determined in step 

25. Check the “Pretrigger” field and input 100 ms. Check the “Post-trigger” field and input 200 

ms. Under “Search Region” click the “Select Button” and click “Active Signal” and “Active 

Trace.” Move the Trigger cursor (2) to some point after the threshold. Then click “OK” and close 

the “Event Viewer” window that opens.”  



   

67 

 

 

29. In the event threshold toolbar, click the “Non-stop”  button. Then go 

to the results page. Record the following values into the spreadsheet:  

a. AP Amplitude is listed as “Peak Amp.” 

b. AP half-width is listed as “Half-width.” 

c. AHP Peak is listed as “Antipeak A.” 

30. Note the “Time of Antipeak” and “Quit” the Event Threshold toolbar.   

31. To find the AHP Time to Peak, place cursor 1 at threshold value after the 

AP peak. Then right click on cursor 2 and select “Cursor Properties.” In the time field, input the 

value from “Time of Antipeak” in the results sheet and click “OK.” Then return to the action 

potential, look at cursor 2 and record the delta time value in mSec as AHP Time to Peak in the 

spreadsheet.   

3.2 Repeat all steps pertaining to AP analysis for the first Action Potential elicited in each of the 

positive step files.  
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33. Delay to first spike is only measured for files in which the only one or two AP’s are elicited 

in the sweep. To find that value, place cursor 1 at the threshold of that AP, then place cursor 2 (to 

the left of cursor 1) at the initial deflection of the trace where the input current was turned on. 

The delta in time of cursor 2 is the Time to initial spike and is recorded as positive. 

 

Literature Review Protocol for Chapter 2 

This protocol was originally developed by Tyler Will, adapted by Garbriella Mamlouk, and 

adapted again by me.  It is included so that it is archived and also to best document the employed 

methods. 

Open up the journal you were given and go to the specific year you are working on. You may 

need to open the journal through the library database. 

1. Once you have the journal open, go to January of 2010 (or whatever month and year you 

are on) and tally up all of the articles that were submitted in in that month (there should 

be two issues per month). Exclude all editorials, reviews, methodology, etc. Once you 

have counted all of the articles, indicate that number in the spreadsheet on the “Total 

Articles” column of 2010 tab, making sure to add it to the correct month. You don’t need 

to open up the articles for this, just simply count them. 

2. Now you will open up each individual article one at a time. 

3. Once you have an article opened, scroll down to the methods section, or where they 

explain their procedures.  You will read this section and find out what animal they used 

(if any, at all).  If it is anything other than rats or mice, discard the article and move on to 

the next one! If you cannot figure out the animal they used, do a search (command F) and 

type in rats and mice/mouse and see if it is in the article at all. If not, they did not use 

those animals and you can discard it.  

4. When you are reading the methods section and it says they used rats or mice, first check 

what sex they used. Here are the definitions of our variables: 

a. Male only: explicitly stated they used only male rats/mice 

b. Female only: explicitly stated they used only female rats/mice 

c. Male/Female Distinction: This means that they used BOTH males and females, 

AND they showed them as two separate groups at some point in the article.  You 

will have to look through the results/graphs to see if they had separate ones for 

males and females. An article will fall under this section also if they state in the 

article that they found no sex differences, thus the data was pooled. I will 

typically do a search (command F) and type in words such as sex, pooled, 

combined, compiled, and grouped to find them easier and faster. 

d. Male/Female No Distinction: This means that they simply used both sexes but did 

not pay any attention to any sex differences throughout the article. 

e. No sex reported: This simply means that they stated that they used rats or mice, 

but they did not indicate what sex they used.  I typically will do a search on the 

page (command F) and type in words such as female, male, sex, or sexes and if 

none of those words are in the article, then I put it in this group. 
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5. Once you figure out what group your article will go in, you will add a number in the 

column that it goes under at the top of the excel sheet.  

6. Next, you will scroll to the bottom of the excel sheet and add a number in the correct 

column for either rats or mice (if they used mice in their article, add it to mice and do not 

change anything about the rats only one). This column will be the same one as the one 

indicated in step 5.  

7. Now that you have determined the animal they used and the sex of that animal, you will 

scroll up to the top of the article and look at the first author and the last author.  

8. If you can clearly tell that they are a man or woman, then that is great, but most of the 

time you cannot tell because they could be from a different country. Thus, you will have 

to copy their name and do a Google search of them and try to find a picture or anything 

that will tell you they are a man or woman. I typically will type in the university they are 

affiliated with, or use Google scholar, or use LinkedIn.  If worse comes to worst and you 

cannot figure out their gender, that is fine and you will add a tally in the “unidentified” 

section 

9. Once you figure out the first and last authors gender, you will scroll to the middle two 

sections of the excel sheet (first and last authors) and add a number to the specific row 

(the rows are for gender) and specific column (this should be the same as column in step 

5). Pay close attention to the row you are adding a number in!! If no gender could be 

found, add it to unidentified row. 

10. Now you have successfully finished one article and can move on to the next one. Once 

you start a month, I would finish it right then and there (don’t stop for the day in the 

middle of a month because you could easily lose your place and have to start that month 

over). 

11. Things on the excel sheet you will not need to add numbers to: Total rat/mice articles, 

totals for gender, total rat articles, and total mice articles. These are already set to be 

added up as you go along with adding numbers in the other columns.  
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Appendix B 

Academic Genealogy, adapted from https://neurotree.org 

 

 

Dr. Veenema is 

not directly a part 

of my genealogy, 

however her 

influence was 

integral for my 

oxytocin receptor 

work. 

My work in the 

Meitzen 

laboratory 

directly rests on 

that performed by 

Dr. Proano, Tyler 

Will, and 

Gabriella 

Mamlouk. 


